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 Functionality and Access Rights 

The Internal Portal is part of REGIS comprising:  

 Internal Portal (for system and project management); 

 External Portal (for online form submission, project portal  and milestone submission and 

profile management); and 

 Contact Relationship Management (for contact management). 

The roles allocated to your user account determine which products you can access and which 

options within each product are accessible.  For example, you may have access to Internal Portal and 

Contact Relationship Management or only to Contact Relationship Management.   

Your accessibility to the functionality is bounded by the access rights set to your user account and 

your role in carrying out your daily tasks. If there are certain screens/functionality which you failed 

to access, please contact the REGIS System Administrator team. 

End of section Functionality and Access Rights 
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 General Data Entry and Navigation functionality 

1. In general, the following are the functionality available in Personal Profile settings:  

   
Click Save upon completing the fields in each screen/page. 

 
Click Reset to clear values in all fields on a page. 

  
Click Edit allows the selected record available for changes. 

  

Click Delete allows removal of the selected record. 

CAUTION: This action is not reversible. 

 
This allows for setting of the number of saved records to 

display on one page. 

 

Typing a phrase/word on the Search box allows for quick 

search on the saved records. 

 

If the number of records are not able to display on one 

page, the rest of the records are viewable by navigating 

the page numbers, or by clicking on Previous and Next. 

 

NOTE:  

a. The system prompts if there are unsaved changes detected when you navigate to 

another page/screen. 

 
Figure 2.1: The system prompt when unsaved changes detected. 

 

b. Clicking Leave this Page will discard any changes and navigate to another page/screen. 

c. Clicking Stay on this page allows user(s) to check keyed in values on screen and saving 

the updated data upon clicking Save. 

End of section General Data Entry and Navigation functionality 
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 Register New User 

You can register by providing your email, first name, last name and password.  External Portal will send 

a verification email to your email address. On receipt of the email, click the link to activate your 

account and gain access to the system.  

This email is sometimes blocked by spam filters. If you do not receive the email within a few moments, 

look in your Junk E-mail folder.  For any further support, check with your corporate IT support or 

contact F1 Solutions user support. 

To register:  

1. Click Sign up now on the login screen. 

 
Figure 3 1: The Sign up now link on the Sign In screen. 

2. Fill up the mandatory fields (*) on the Register screen and perform the Captcha verification. 

3. Click Register upon completion. 

 
Figure 3 2: The Register screen. 
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4. Upon successful registration, the following screen will be shown and email is sent to the 

registered email address. 

 
Figure 3 3: Account successful registered. 

5. Click on the link in the email to activate registered account. 

 
Figure 3 4: Click on link in email to activate account. 

6. The Account Activation screen opens automatically in a browser as follows:  

 
Figure 3 5: Successful account activation. 

7. Click Sign In to sign in to the system from the Sign In screen. 

 
Figure 3 6: Sign in to REGIS using your Username and Password. 

  



 

 
REGIS - Internal Portal v1_1 Page 15 of 106 
 

DRAFT v1.1 

8. Upon first time sign in, the system prompts for a password change. 

 
Figure 3 7: Changing password upon first time sign in. 

9. You will be able to access the system upon successful password change by clicking Home. 

 
Figure 3 8: Successful password change. 

End of section Register New User 
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 Login to External Portal 

Once you are registered and your account is activated, you can login to External Portal:  

1. Key in the Username and Password into the designated boxes on the sign in screen and press 

Enter or click Sign In. 

 
Figure 4 1: The REGIS sign in screen upon keying in Username and Password. 

2. Upon successful sign in to REGIS, you will need to agree with the License Agreement by clicking 

Sign In to proceed. 

 
Figure 4 2: The License Agreement screen after successful sign in with Username and Password. 

3. Clicking Decline will bring you back to the Sign In screen. 

4. If the Sign In failed due to problems with the Username and Password, the following message(s) 

will show on screen. 

 
Figure 4 3: The messages shown on screen upon failure to sign in. 
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IMPORTANT 

1 You will not be able to proceed with any system usage until you are successfully signed into 

the system. 

2 The first page you see upon successful sign in to the system may be different from other 

users’ due to your role and the access to functionality in the system. 

3 One (1) computer allows for one user account sign in at any one time. For e.g., if you are 

signed in as UserA, please DO NOT use another browser or opening a new browser tab to 

sign in as a different user. 

Table 4 1: REGIS Sign In – Important points to note. 

 

4.1 Forgot Password 
If you have forgotten your password you can follow the steps below to reset your password. An email 

will be sent to you containing a link to re-verify your login 

1. Click Reset your password on the Sign In screen. 

 
Figure 4 4: The Reset your password link on Sign In screen. 

2. The Reset Password screen prompts for your User Name. 

 
Figure 4 5: The Reset Password screen. 
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3. You will need to perform the Captcha verification before clicking Reset Password. 

 
Figure 4 6: Perform the Captcha verification. 

4. Upon Captcha verification, and clicking Reset password, an email will be sent to the user’s 

registered email address for the next action to proceed. 

 
Figure 4 7: Keying in the user name and successful Captcha verification. 

End of section Login to External Portal 
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 Navigation in REGIS External Portal 

1. You can navigate directly to a system module, e.g. Projects, by selecting a tile on the Start page.  

IMPORTANT 

1 Only modules that are relevant to your role are displayed.  For example, unless you have a 

Project related role, you will not see the Projects icon. 

2 The first page you see upon successful sign in to the system may be different from other 

users’ due to your role and the access to functionality in the system. 

3 One (1) computer allows for one user account sign in at any one time. For e.g., if you are 

signed in as UserA, please DO NOT use another browser or opening a new browser tab to 

sign in as a different user. 

Table 5 1: REGIS Sign In – Important points to note. 

 
Figure 5 1: Keying in the user name and successful Captcha verification. 

2. From anywhere in the system, you can navigate to the Start page by selecting the Start in the 

top left hand corner of the screen. 

 
Figure 5 2: Click Start to navigate to other functionality of the system. 
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5.1 Search 
At the Search text box, you can search for related Projects by typing in the phrases of the project 

name. 

 
Figure 5 3: Type in a phrase on the Search box. 

 

5.2 Tasks 
Outstanding Tasks are shown when you click on Tasks from the Start menu. 

 

Figure 5 4: The outstanding tasks and its priority. 

1. Selecting the task(s) by checking the box(es) changes the task(s) from active to complete. 

 
Figure 5 5: The task is marked as completed. 
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5.3 Help 
Provides REGIS Internal Portal information available on the right side of the page. 

 
Figure 5 6: The help information on screen. 

 

5.4 Settings 
1. Click on Settings. 

2. The following Settings screens allows for changes, as follows:  

 
Figure 5 7: The Settings screen. 

 

Menu Fields Remarks 

Settings 

Dashboard Theme The colour of Dashboard, whether Light or Dark. 

Default Landing Page This is the Home page. Selectable options 

include Applications, Dashboard, Home, and 

Projects. 

NOTE: Please sign out and sign in again to see 

the changes. 

Change 

Password 

Current Password Type in the current password 

New Password Type in the new password. Please follow the 

password rule on screen. 
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Menu Fields Remarks 

Confirm New 

Password 

Re-type in the new password. 

Email Footer 

Email footer box Type in the required email footer text message. 

The text format menu bar allows for text 

formatting, if required. 

Table 5 2: The available Settings functionality. 

 

IMPORTANT 

1 The Settings screen is accessible base on the user’s access rights. Ensure the necessary 

access rights are assigned to the respective users. 

Table 5 3: REGIS Internal Portal Settings – Important points to note. 

End of section Navigation in REGIS External Portal 
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 Home/Calendar 

The interactive Calendar summarises due dates for project milestones, issues and risks and tasks 

allocated to you. 

IMPORTANT 

1 You will need to have access to view Projects to view the interactive calendar. Ensure the 

necessary access rights are assigned to the respective users. 

Table 6 1: REGIS Internal Portal Settings – Important points to note. 

 

 
Figure 6 1: The Calendar screen. 

 

The available Calendar functionality allow users to:  

1. Customise the calendar display by selecting and deselecting the Meeting, Milestone, Task, Issue, 

Risk and Review buttons. Deselecting display is shown as grey indicators. 
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Figure 6 2: The Calendar screen without any events displayed. 

 

 
Figure 6 3: The Calendar screen displaying all events. 
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2. The calendar displays include the following:  

Indicator Remarks 

Meetings Clicking the Meeting item(s) will go to the Meeting Details page. 

Milestone Clicking the Milestone item(s) will go to the Project Milestone page. 

Task Clicking the Task item(s) will go to the Project Tasks page. 

Issue/Risk Clicking the Issue/Risk item(s) will go to the Project Issues page. 

Review Clicking the Review item(s) will go to the Application Review page. 

Table 6 2: REGIS Internal Portal Calendar notification items are clickable. 

3. Select the month, week or day views and navigate using the right and left arrows. 

 

Figure 6 4: The navigation for the Calendar screen. 

4. Select the Today button to navigate to the current date  

5. You may notice that some milestone icons have a document icon attached.  This indicates that 

a milestone report has been uploaded in the Project Portal 

 
Figure 6 5: The indicator of upload document in Calendar screen. 

End of section Home/Calendar 
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 Time-out prompt 

If you leave your session for a period of time, the system will prompt you to either end or extend the 

session.  

1. Select Yes to extend the expiry point for the session 

2. Select No to log out of REGIS Internal Portal and REGIS Contact Relationship Management 

 

Figure 7 1: The time-out warning screen. 

End of section Time-out prompt 
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 Contacts 

The Contacts functionality links to REGIS Contact Relationship Management. Therefore, to get full 

usage of the functionality, you will need access rights to REGIS Contact Relationship Management. 

To access Contacts functionality:  

1. Click on Start to view the main menu and click on Contacts. 

 
Figure 8.1: The Contacts option in main menu. 

 

2. The functionality of the Contacts page are as follow:  

 
Figure 8.2: The Contacts page. 

 

8.1 Search 
1. Clicking on the Search icon navigates to the Search page. 

 
Figure 8.3: The Search page. 
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2. There are existing search filters on the left of the screen to ease the usage of the search function. 

Click on the required available filter(s) and it will be plotted to the right of the page. 

 
Figure 8.4: The Contact’s search criteria. 

 

3. Select/key in the specific value(s) of the search criteria fields and click Find. 

4. The search result(s) will be shown on screen below the search criteria. 

 
Figure 8.5: The Contact’s search result. 

 

5. The search results can be displayed as follows:  

 

Exports results to a 

Comma-separated 

Value (CSV) file. 

The CSV file downloads as per the browser’s setting. 
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The results display in 

table form and on the 

same page. 

 

 

The results are marked 

on a map based on the 

contacts’ address(es). 

 

Table 8.1: The Contact’s different displays for search result(s). 

 

6. When the search results are in table form, clicking Edit (     ) of the contact records allows for 

editing in REGIS Contact Relationship Management. 

 
Figure 8.6: The Contact is editable in REGIS Contact Relationship Management. 

 

8.2 New contact 
1. Clicking New contact navigates to the New contact screen. 

 
Figure 8.7: The New Contact page. 
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2. Select a Contact type from the drop down listing, click the blue arrow (>) to go to next page. 

 
Figure 8.8: The New Contact page – select Contact Type. 

 

3. Fill up the details in the Person details page. 

 
Figure 8.9: The New Contact page – filling in Person details. 

 

4. Click the blue arrow (>) to go to the Confirmation page. 

 
Figure 8.10: The New Contact page – Confirmation of details. 

5. At the Confirmation page, there is a field to confirm whether the contact is duplicate. 

6. Click  to confirm creation of new contact. 

7. Upon successful creation of a new contact, you will be redirected to REGIS Contact Relationship 

Management, the Contact Details page. You may proceed with filling up the rest of the 

necessary information, if required. 
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Figure 8.11: The contact details in REGIS Contact Relationship Management. 

 

IMPORTANT 

1 The Possible duplicates found option needs to be Yes to proceed with new contact 

creation. 

Table 8.2: The Contact’s different displays for search result(s). 

 

8.3 Merge Contact 
1. Clicking Merge contact displays the Merge Contact screen. 

 
Figure 8.12: The Merge contact screen. 

 

2. Select the Contact type from the drop down listing. 
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Figure 8.13: The Merge contact screen. 

 

3. Select the Target contact and Source contact by clicking on . 

4. Click the blue arrow (>) to go to the Preview page.  

 
Figure 8.14: The Merge contact preview screen. 

 

IMPORTANT 

1 Inactive contacts cannot be set as Target contact or Source contact 

2 The Target contact and Source contact cannot be locked. 

3 The Target contact and Source contact must have same ORCID. 

4 Source contact information will be merged to the Target contact. Should there be 

existing records of the Target contact, merging will not overwrite the Target contact’s 

record of a specific Type. 

5 The system deletes Source Contact upon successful merging. 

Table 8.3: Merge Contacts – Important points to note. 
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8.4 Bulk Update 
1. Clicking Bulk update goes to the Bulk Update page of REGIS Contact Relationship Management 

in a new browser tab. 

 
Figure 8.15: The Bulk Update screen in REGIS Contact Relationship Management. 

 

2. The Bulk Update functionality allows for updates on the Phone Number and Email Address of 

more than one record. 

3. Select Phone Number or Email Address. 

4. Type in the Search text and Replace text as follows:  

 
Figure 8.16: The Bulk Update screen with sample values. 

 

Field Remarks 

Search text This is the Phone Number/Email Address that you want to replace. 

Replace text This is the Phone Number/Email Address that you want to replace with. 

Table 8.4: The Contact’s different displays for search result(s). 

The above example in the screen will replace all Email Addresses that has ‘josh.yip’ with ‘joshyip’. 

 

5. Clicking SEARCH will bring you to the results preview page. 
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Figure 8.17: The Bulk Update screen with preview of new value(s). 

 

6. Upon clicking UPDATE, the old values will be replaced with the new values. 

8.5 Contact Groups 
1. Clicking Contact groups goes to the Maintain Groups page. 

 
Figure 8.18: The Maintain Groups screen. 

 

8.5.1 Search for existing groups 

1. Key in the required Group name on the Search box and click Search. The search result(s) displays 

on the same page. 

 
Figure 8.19: The search result. 
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2. Clicking Edit ( ) displays the related type (Application, Contact, Project, User) tied to the 

group. 

3. Clicking Menu ( ), then Add Contacts, allows to add the related type (Contact, User, ) to the 

required group. 

 
Figure 8.20: Add the related type item to group. 

 

4. Type in the required and press Enter or click . 

5. Click/Tick the check box(es) to select items to add. 

6. Click  to add the selected records. 

 
Figure 8.21: Add the related type item to group. 

 

7. The items/records added are in green:  
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Figure 8.22: Add the related type item to group. 

 

8. Click Save ( ) to save the changes. 

8.5.2 Add new group 

1. From the Maintain Groups screen, click on Menu ( ), and select Add group. 

 
Figure 8.23: Click Add group. 

 

2. The New Group page is displayed. 

3. Fill in the following fields:  

Field Remarks 

Type Select the Type of group. This defines the items to be available for tagging to 

the new group. 

Group Name Key in the required Group Name. 

Description Key in a description for the new group. 

Table 8.5: The fields of a group. 
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Figure 8.24: Click Add group. 

 

4. Click on Menu ( ), and select Add application. Please take note that the Menu is based on the 

selected Type. If it is of type Application, you will see the Add application option. 

5. The available selection item to be added are Applications. 

 
Figure 8.25: Click Add applications. 

 

6. Click  to add the selected records. 

7. Click Save ( ) to save the changes. 

8.6 Contact Address Coordinate 
1. Clicking on Contact address coordinates opens a new browser tab that navigates to REGIS 

Contact Relationship Management’s Empty Coordinate Report. 
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Figure 8.26: The Empty Coordinates Report in REGIS Contact Relationship Management. 

 

8.7 Unlock Contacts 
1. Clicking Unlock contacts navigates to the Unlock Contacts page. 

 

Figure 8.27: The locked contacts are displayed on the page. 

2. The following are the functionality of the Unlock contacts page:  

 

Exports the Unlock contacts list to a Comma-Separated Value (CSV) file. 

 

Refresh the list of Unlock contacts. 

 

Unlock the affected contact(s). 

Table 8.6: The standard functionality. 

End of section Contacts 
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 Project Management Options 

9.1 Simple Project Search 
You can search for projects by Title, Keyword, Reference or Project Id using the basic search options.  

1. Click Start and select Project. 

 
Figure 9 1: The Projects selection in the menu. 

2. Click on the Projects tile. The Project home screen is displayed. 

 
Figure 9 2: The Projects selection in the menu. 

3. Click on the Search tile in Project home screen. 

 
Figure 9 3: The project Search tile menu. 

 

4. Enter required words or partial words to search. 

5. The left side of the Project search screen is a list of filter criteria that can be used. Click on the 

area to include the required criteria.  
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6. Click Find and the results will be display below the search criteria section. 

 
Figure 9 4: The project Search page with selected criteria and results. 

 

7. Click on a project in the list to open the project in View mode; or click  to open the project 

in Edit mode. 

8. On the Search box, users are able to select the search phrase on the following:  

 
Figure 9 5: The project Search scope. 

 

Search Scope Remarks 

All Searching scope includes Project Title, Short Title, Tags, 

Application Identifier and Project Identifier. 

Title Searching scope is on Project Titles only. 

Short Title Searching scope is on Project Short Titles only. 

Tags Searching scope is on Project Tags only. 

Application Identifier Searching scope is on Application Identifier of the projects only. 
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Identifier Searching scope is on the project identifier. 

Table 9 1: The project Search scope. 

 

Tips:  

 Click the Reset button to clear the search bar. 

 To view all projects, leave the search bar blank. 

 Click the Export icon ( ) to export the project list to a Comma Separated File (.csv) file. 

9.2 Copy Project 
The Copy project option can be helpful when creating projects in REGIS Internal Portal with similar 

attributes. As with the New project option, you can use the Copy project option to create the new 

project, with basic attributes, and add and update project details and milestones in the Project Viewer. 

 
Figure 9 6: The copy project screen. 

 

You will not be able to perform any Net related functions for a copied project, such as online expert 

reviews or milestones submission through the Project Portal; however, you will be able to manage the 

project as normal for most functions. 

1. Search and select the Project ID for the project to copy. 

 
Figure 9 7: The copy project screen. 
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2. Enter a new project number and click Copy. 

 

Figure 9 8: Selected existing project and new project number. 

 

3. All standard details, related documents and milestones will be copied to the new project. You 

will notice that some information e.g. Comments are not copied. 

9.3 Change project identifier 
The project number is used to identify the project within REGIS Internal Portal. You can modify the 

project number using the Change project identifier option. 

1. Search and select the Project ID to change 

 
Figure 9 9: The change project identifier screen. 

 

2. Enter the Project ID to confirm. 

3. Enter a new project number. 

4. Click OK. 

 
Figure 9 10: The change project identifier screen. 
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9.4 Unlock Project 
Many people can open and view the same project at the same time; however, only one person at a 

time can edit and save changes to a project. 

IMPORTANT 

1 When you select the Project Edit option (either from the search results screen or the Project 

Viewer floating menu (right hand sidebar), the system will pop-up an alert (bottom right of 

the screen) to say that the project has been locked. This allows you to edit and save changes 

without conflicting with other users. 

2 A user with role Project Unlock can unlock projects that have been inadvertently locked and 

are therefore unable to be updated. 

Table 9 2: Important points for projects. 

 

 
Figure 9 11: The Unlock project screen, showing currently locked projects. 

End of section Project Management Options 
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 Application Management 

The Application(s) are available upon registration of a project. Users are required to go to the 

Application page of Projects to fill up the necessary sections and performing submission. 

 
Figure 10 1: The Application home screen. 

Application Search: Use the application search screen to filter the application list and navigate to the 

Application Viewer.  Use the Application Viewer to view basic application information including a 

summary of internal and external reviews; create application related tasks and comments and add 

related documents. 

Manage Reviews: Expert Reviewers/Reviewers are allocated to applications.  They can complete and 

submit an online assessment and comment on the value of each application.  The data is then collated 

into a report which can be used to inform the outcome of the application.   

Process Decision: Decision notification letters are generated, distributed and acknowledged.  

Unlock Application: Unlocks available locked applications. 

Research Ethics Governance Information System: Launches the REGIS External portal. 

10.1 Application Search 
The Application Search screen allows you to:  

1. List applications using filter criteria 

2. View basic information about applications   

3. Record an eligibility check for an application (if eligibility is turned on for your implementation 

you will see the eligibility ( ) and download ( ) buttons displayed in the grid). 

 

Figure 10 2: The Application Search screen. 

Tips:  

 Data for applications that are not granted funding will only ever be visible within the Application 

viewer by searching for applications by status ‘Unsuccessful’ 
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10.1.1 View all applications 

To view all applications, select the Find command and browse through the results. 

10.1.2 Search for applications 

To filter the search results using a search filter:  

1. Select the arrow to the right of the filter name to add the filter to the filters area of the screen 

 
Figure 10 3: Clicking the arrow will add the filter. 

 

2. Select the filter element(s) to search by 

 
Figure 10 4: Selecting the options from filter. 

 

3. Click Find and page through the search results. 

 

Notes:  

 Select the X to the right of the search filter to remove it from the filters form 

 Select an application in the search results to open the application in the Application 

Viewer 

 Enter free text into the Search field to limit the search results to applications that include 

that keyword, application identifier 
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10.2 Application Viewer 
To view the application details in the Application Viewer:  

1. Search for the application. 

2. Click the application in the grid. 

 

Figure 10 5: Selecting the application from the search results. 

 

3. The Application will be shown on the Application Summary page. 

 

Figure 10 6: The application is shown on the applications summary page. 

 

4. Navigate to the Details, Management and Evaluation nodes as required for more information 

on the application. 
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Notes:  

 The floating toolbar includes the following commands:  

 

This is Edit; to create tasks, enter comments and upload additional application 

related documents. 

 

This is Favourite; to add to the Favourites list on the Application menu. 

 

This is Copy; to create a copy of the application. 

 

This is Comments; to add comments to the application. 

 

This is Unsubmit; to unsubmit the application. 

 

This is Eligibility; to add and check on the eligibility of the application. 

Table 10 1: The floating toolbar. 

 

 You will not be able to edit an application where the status is ‘In progress’. 

10.3 Eligibility Assessment Wizard 
An Eligibility assessment is performed against set criteria. Each criterion is marked as either eligible or 

not and a comment may be added. A user with delegation eligibility approval A can assess the 

application and a user with eligibility approval B can approve the assessment and update the eligibility 

status to either Eligible or Ineligible (alternate statuses may Approved for transfer or Not approved for 

transfer). Alternately, a user with both Eligibility A & Eligibility B can review and approve in the same 

step. 

1. From the eligibility pane you can choose to review the previously performed eligibility review, 

to record an assessment of the review (approve or disprove the recommendation) or to 

download the report. 

 
Figure 10 7: The Eligibility Assessments screen for an application. 

 

2. Click the + symbol to begin an eligibility assessment. The wizard will step you through the 

process. 
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3. Select the eligibility icon  to display the eligibility assessments pane. 

4. View the application  and attachments  from the application list or from within the 

wizard  

5. Applications and attachments are available for download by clicking  or 

. 

6. A user with both delegation levels can record the eligibility review and approve the review in 

the same step. 

10.3.1 Update the status 

IMPORTANT 

1 You must have the application edit role to apply a new status. 

2 Note that you must first select the Edit option to view the application in edit mode. 

Table 10 2: Important points for status updates. 

 

 
Figure 10 8: The application status. 

 

From the Application Viewer heading:  

1. Ensure you are in Edit mode, else click on the  to go to Edit mode. 

2. Select the Status displayed in the top right hand corner of the Application Viewer. 
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Figure 10 9: The Application status drop-down list for selection. 

 

3. Update the status by selecting the required status from the drop-down list. 

4. Click  to save. 

 

From the Management node:  

1. Select Management>Status 

2. Select the Add Status option from the menu 

 
Figure 10 10: Adding the Application status from the Status menu. 

3. Select the Status from the Status dropdown. 

 
Figure 10 11: Select the Application status from the Status drop down list. 

4. Select OK to save the new status. 
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10.4 Manage Reviews 

1. Clicking on Manage Reviews displays the Manage Reviews page. There are available filters on 

the left which are usable by clicking the arrow to the right of the filter to add it into the page 

for values input/selection. 

 
Figure 10 12: The Manage Reviews page. 

 

2. Note the visualisations on the Manage reviewer access screen provide instant feedback on the 

status of reviews. 

 
Figure 10 13: .Search results and the review statuses. 

  



 

 
REGIS - Internal Portal v1_1 Page 51 of 106 
 

DRAFT v1.1 

3. Clicking on the search result item displays the Edit Review page as follows:  

 
Figure 10 14: The Edit Review screen. 

4. Click  to edit the selected application. You will be able to change the Name, Description, 

Review type, Date due, and Date created. 

 
Figure 10 15: Click Edit to enable screen in Edit mode. 

5. Click on Applications to add any required applications to the review 

 
Figure 10 16: Click on Applications menu and click Add application to add in application. 
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6. Click Reviewers to add additional reviewers.  

 
Figure 10 17: Click on Reviewers menu and click Add reviewer. 

 

10.5 Process Decision 
The process decision screen assists you to generate the decision notification letters, distribute them 

via email, and acknowledge receipt by the applicant. Alternately, you may upload a letter generated 

outside the system as either a word document or a PDF which will be attached in the email. 

 
Figure 10 18: The Process Decision screen. 

 

Tip:  

 This process can be performed end-to-end for a single application, or you may choose to 

send all emails in a single action.  For more information on sending the decision emails in bulk 

see Bulk Decision Email section below. 

1. Select Applications>Process Decision. 

2. Select the Decision Status and/or Notification Status. 

 
Figure 10 19: The Process Decision screen. 

3. Click Find. The results are shown on the same page. 

4. Click to select the application. 
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10.5.1 Bulk Decision Email 

You may choose to send all decision emails at the same time.  Before beginning this process, ensure 

that the notification status is ‘Pending generation’ i.e. the letter has been generated (if required) and 

uploaded for each application.  To send the decision email in bulk:  

1. Select Process Decision 

2. Select Notification Status “Pending Generation” 

3. Select the Items per page ‘All’ 

4. Select the checkbox to select all items on the page 

Tip: To review the letters prior to sending, select Bulk Download from the menu. 

5. Select Bulk send email 

 

Figure 10 20: The Bulk send email option. 

 

6. The following notification will be displayed 

 
Figure 10 21: The Bulk send email confirmation screen. 

7. Select Yes to confirm the action 

The emails are sent to the Pending Emails queue.  To access the Pending Emails queue you must 

be a user with Admin role. 

End of section Application Management 



 

 
REGIS - Internal Portal v1_1 Page 54 of 106 
 

DRAFT v1.1 

 Reporting 

REGIS Internal Portal consists of System reports and the ability to create custom reports using the 

Report designer.  Reports that you have accessed recently are listed in the Recent Reports list. You can 

mark reports you access regularly as favourites and they will always appear in the Favourites list. 

 
Figure 11 1: The Report home screen. 

 

11.1 System Defined Reports 
The System defined reports are presented in a structured manner according to function.  To view the 

system defined report:  

1. Start > Reports 

2. Select System Reports 

 

Figure 11 2: The System reports menu. 

 

3. Select a report sub-menu, e.g. Application 

 
Figure 11 3: The System reports sample. 

 

11.2 User Reports 
Reports that you create, or that have been shared with you, are visible in User Reports > My Reports. 

 
Figure 11 4: The System reports sample. 
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To run a report:  

1. Select the report from the menu 

2. The report viewer opens and the report is loaded 

11.3 Report designer 
The Report designer page takes you straight to the download page.  Select Install to download a 

setup file.  You can find the setup file in the downloads folder or on the downloads toolbar. 

 
Figure 11 5: The Dashboard/Report Designer download prompt. 

Notes:  

 You can download the report designer from the User reports menu or from the Report 

Designer page. 

 Select the Star  in the floating toolbar to mark the report as a favourite 

 Select the Share  option to share a report with another user (this may be a report you 

have designed or that has been shared with you) 

 Select the Delete  option to remove the report from your User Reports menu.  If you 

have shared this report with another user, selecting Delete will not remove the report 

from their My reports menu.  If a user shared the report with you, you can select Delete 

without impacting the original users access to the report.  

To download Dashboard/Report Designer:  

1. Select the Setup file and follow the prompts to install the Dashboard/Report designer. 

 
Figure 11 6: The Dashboard/Report Designer download prompt. 
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2. Select the Report designer 

 
Figure 11 7: The Dashboard/Report Designer selection after successful installation. 

 

3. Select the New report option to launch the query designer. 

4. See the Creating a data source topic for information on using the Query designer 

5. Design your report 

6. Select Server > Save or Server > Save As (only reports saved to the Server are visible within 

REGIS Internal Portal) 

7. Enter a name for the report  

8. Enter a description of the report 

9. Select OK 

10. The report is now visible in the User reports list 

  

11.4 Share a report 
To share a report:  

1. Select the report from the User Reports > My reports menu to view the report in the report 

viewer. 

2. Select the Share option from the floating toolbar. 

 
Figure 11 8: Sharing of user report(s). 

3. Click the + icon to display the User search pane (on the right hand side of the screen) 

4. Search for the person you would like to share the report with. 
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Figure 11 9: Sharing of user report(s). 

 

5. Select the person from the list. 

 
Figure 11 10: Selecting user(s) to share report with. 

6. Repeat steps 4 and 5 as many times as you require 

7. Select the Share button. 

8. The report is now listed in the My reports menu for each person you selected to share the 

report with. 

End of section Reporting 
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 Meetings 

12.1.1 Meetings 

The Meeting feature facilitates the creation of meeting events and invitations related to applications 

and projects. 

To create a new meeting:  

1. Click on Create new meeting from the menu. 

 
Figure 12 1: Selecting user(s) to share report with. 

 

2. Key in and select the necessary values. 

12.1.2 Attendees 

1. From the Attendees sub-screen menu, click Add Attendee and search for a user. 

 
Figure 12 2: Selecting attendee(s) to add into meeting. 

 

2. Check on the box the left of the user. 

3. Click  to add as attendee to the meeting. 

12.1.3 Applications 

1. From the Applications sub-menu, click Add application. 

2. Search for application(s) based on a program or status, or just click Search. 
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3. Select application(s) by checking/ticking the box beside an application. 

4. Click  to add selected application(s) to the meeting. 

 
Figure 12 3: Selecting Application(s) to add into meeting. 

 

12.1.4 Milestones 

1. From the Applications sub-menu, click Add milestone. 

2. Search for milestone(s) based on a program or status, or just click Search. 

3. Select milestone(s) by checking/ticking the box beside an application. 

4. Click  to add selected milestone(s) to the meeting. 

 
Figure 12 4: Selecting milestone(s) to add into meeting. 

 

12.1.5 Amendments & Other Notifications 

1. From the Amendments & Other Notifications sub-menu, click Add related document. 

2. Search for document(s) based on Project/Application, a program, document type or just click 

Search. 

3. Select document (s) by checking/ticking the box beside a document. 

  



 

 
REGIS - Internal Portal v1_1 Page 60 of 106 
 

DRAFT v1.1 

4. Click  to add selected document (s) to the meeting. 

 
Figure 12 5: Selecting document(s) to add into meeting. 

12.1.6 Meeting Documents & Other Business 

1. From the Amendments & Other Notifications sub-menu, click Add document. 

2. Upload required documents by clicking on the box or just drag a document from other 

location and drop into box. 

3. Click Upload. 

 
Figure 12 6: Uploading document(s) to add into meeting. 

End of section Meetings 
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 The Project Viewer  

The Milestone Summary view is the default project viewer screen. From here you can navigate to the 

Details, Management or Evaluation nodes or select a milestone to view the milestone details. 

If you have Edit Project role you may select the Edit option (from the floating toolbar on the right 

hand side) and modify the project data. As you navigate away from a screen the system will 

automatically save any changes you have made. To cancel your changes, select the red cancel button 

before you navigate to the next page. 

If the project is locked by another user, the lock icon will appear.  Hover over the icon to view the 

username.  If the project has been locked inadvertently, ask your system administrator to unlock the 

project. 

If you are viewing the project in view only mode, you may click on the eye icon to view tasks, issues, 

risks and contact details. 

 

Figure 13 1: The Tasks screen, under Project Management. 

 

13.1 Milestone Processing 
The Milestones node is the default view for the project. By default, milestones are grouped by 

Expenditure and Income.  
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Figure 13 2: The Milestone Summary. 

Tips:  

 Select Organisation in the Group By dropdown to group by organisation 

 Enter search text in the filter box to view only milestones that match the search text 

 Select a milestone in the grid to view the milestone details and process the milestone.   

 Where a milestone report has been uploaded in either the Project Portal or when processing 

(Attach Minutes step) a document icon is displayed in the milestone view 

 
Figure 13 3: The document indicator for milestone in project, shown in Milestone Summary. 

13.1.1 Milestone Menu 

The milestone details page lists detailed information on the selected milestone.  In edit mode (select 

the Edit option from the floating toolbar to the right) menu options may include the following 

options:  
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Figure 13 4: The available options for milestone summary. 

 

Menu Option Remarks 

Change title A milestone title is optional information to assist users to identify milestones. 

Change type The milestone type is important for identifying milestone behaviour and the 

information saved with the milestone. 

Change date Often when one milestone date changes, milestones down the track are impacted. 

The milestone date wizard steps you through the process of entering a new date 

and viewing a list of milestone impacted by selecting the offset option. 

Receive milestone Enter the received date to record when the milestone report was received.  Note 

that this may be different to the processed date. 

Process milestone The process milestone wizard has four steps for recording information about a 

milestone and payment information. 

Step 1: update the received date and select a status for the milestone (mandatory) 

Step 2: enter a performance rating for the milestone (optional) 

Step 3: enter information relating to outputs (optional) 

Step 4: enter payment information (optional) 

Undo milestone The undo milestone can be used to remove the milestone processing data and 

milestone received date. 

Delete milestone The delete milestone option will remove all milestone data.  You can only delete a 

milestone that has a status of Pending or Received. 

Table 13 1: The available options for milestone summary. 

13.1.2 Milestone Information Pages 

This milestone information pages give you a summary of milestone details and dates.  You can modify 

the organisation and milestone amount in the form. The dates, title and type can be edited via menu 

options. Each of the pages is described below. 
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Page Remarks 

Milestone detail The milestone detail text box can be updated to include information relevant to 

the milestone both prior to processing and after processing the milestone for 

payment. 

Milestone 

justification 

The milestone justification text box can be updated to include information relevant 

to the milestone both prior to processing and after processing the milestone for 

payment. 

Milestone 

documents 

Milestone related documents can be submitted from the REGIS External Portal. 

These can be viewed and downloaded from this page. 

Milestone actions Overdue milestone reminders and processing emails are detailed in the milestone 

actions screen. You can add a use generated milestone action by selecting the Add 

milestone action option from the menu. 

Milestone ratings Ratings are used to record the quality of the milestone report. 

Milestone history All system and user generated actions are recorded and can be viewed in details in 

the history pane. Select the arrow to display or hide the details.  All populated 

fields and fields that have changed are recorded. 

External 

assessments 

 

External Milestone Assessments are created and managed in this screen.  Select 

the Information icon  to view details of the milestone. In edit mode you will be 

able to. 

Table 13 2: The project milestones’ available pages. 

 

Tips:  

IMPORTANT 

1 Once a milestone is processed you can’t change data on the information page. 

Table 13 3: The important points for project milestones. 

13.1.3 Change Milestone title 

To change the title of a milestone:  

1. Select the milestone in Edit mode 

2. Select the Change Title option from the menu 

 
Figure 13 5: The Change Milestone Title screen. 
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3. Complete the form 

4. Select Save. 

13.1.4 Change Milestone Type 

1. Select the Milestone in Edit mode 

 
Figure 13 6: The Change Milestone Type screen. 

2. Select the Change Milestone Type option from the menu 

3. Complete the form 

4. Select Save  

13.1.5 Change Milestone Date 

Often when one milestone date changes, milestones down the track are impacted. The milestone date 

wizard steps you through the process of entering a new date and selecting the offset options.  

1. Select the milestone in edit mode 

2. Select the Change Date option 

3. Enter the new date and a reason 

 

Figure 13 7: The Change Milestone Date screen. 
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4. Select the Next step 

5. Select the Offset option (Yes or No) 

6. Click the Finalise button 

7. Select yes to generate an email  

8. Enter the email details 

9. Select Send 

 

Receive a milestone 

Enter the received date to record when the milestone report was received.  Note that this may be 

different to the processed date. 

1. Select the milestone in edit mode 

2. Select the Receive milestone option 

 

Figure 13 8: The Change Milestone receive milestone screen. 

 

3. Complete the form 

4. Select Save 

13.1.6 Process a Milestone 

The process milestone wizard has four main steps. Additional steps may be included if the External 

Milestone Assessment feature is enabled. 

 
Figure 13 9: The process milestone menu. 

 

1. Update the received date and select a status for the milestone (mandatory) 



 

 
REGIS - Internal Portal v1_1 Page 67 of 106 
 

DRAFT v1.1 

 
Figure 13 10: The process milestone wizard. 

 

2. Attach minutes (optional) 

3. Enter a performance rating for the milestone (optional) 

4. Enter payment information (optional) 

5. Review and send email (optional)  

Tip:  

 You may attach multiple files to the email at the Send email step.  Click or drop your file on 

the drop zone to attach it to the email.  

 System generated emails can be viewed in the Pending Emails queue (for users with System 

role only). 

 

Figure 13 11: The process milestone wizard. 
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13.1.7 Undo Milestone  

The undo milestone can be used to remove the milestone processing data and milestone received 

date. It will also undo any acquittal data and the acquittal document associated with the milestone. 

 
Figure 13 12: The process milestone undo prompts confirmation. 

13.1.8 Delete Milestone 

The delete milestone option will remove all milestone data. You can only delete a milestone that has a 

status of Pending or Received. 

 
Figure 13 13: The process milestone undo prompts confirmation. 

 

13.2 Project viewer – Details 
Summary 

The Summary screen displays project and application information.  If your user role allows you to edit 

a project, you will be able to select the Edit option  from the floating toolbar and update 

information for the project as required.   

When in Edit mode you will be able to select additional options from the menu including:  

1. Change project start date:  This wizard will step you through changing the start date with 

the option for flow-on changes to project milestones, cash contributions, project end 

date, and contributions by application and other.  If you change the project start date 

forward or backward by x number of days, each of these elements will be adjusted 

accordingly. 
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2. Perform a project variation: The project variation wizard is covered in more detail below.  

This wizard allows you to quickly change all project dates, add and remove contacts, and 

create a variation to the contract with all the updated details. 

3. Update Priority Mapping: Selecting this option will update the program, national and rural 

research priorities and classifications using a predefined set of metadata. 

 
Figure 13 14: The project summary screen. 

 

Tips:  

 The project start and end dates are used to generate year based reports 

 An application transferred from REGIS External Portal will have a unique Application ID.  If the 

application was created in REGIS Internal Portal, you will see the text ‘No link to REGIS External 

Portal application’ 

 The nodes visible in the Details pane will vary between application types and depending on 

whether the application is created in REGIS External Portal or REGIS Internal Portal 

 The Project Owner dropdown allows you to allocate a project owner.  The project owner is 

able to view and manage details of the project in the project portal e.g.  upload milestone 

reports, view project agreement and manage KPIs.  For more information on the Project Portal 

view the help for REGIS External Portal end users and search for project portal. 

Organisations 

The organisations listed are linked to the project in some way. There is only ever one principal 

provider. 

 
Figure 13 15: The project organisation screen. 
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Tips:  

 To view the organisation in REGIS Contact Relationship Management, you must have the 

correct permissions levels 

 You must have one principal provider 

 Select the edit option to add a new organisation or alter the principal provider setting 

 Select a new principal provider to change this setting 

 To add additional organisations to the list select the Add option from the menu  

 Select the Save option or navigate away from the screen to permanently save your changes 

Related applications 

The relating application(s) are displayed in the Related applications screen:  

 
Figure 13 16: The related applications of the project. 

 

13.2.1 Change project start date 

Select Change Project Start date from the menu to change the start date and make flow-on 

adjustments to the project milestone dates, project end date, and contribution dates. 

To change the project dates:  

1. Select the Summary page in the Project Viewer 

2. Select Change project start date 

 
Figure 13 17 : Change project start date menu. 
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Figure 13 18 : Change project start date. 

3. Select Flow on change to change all listed project elements 

4. Enter a new start date  

5. Select Save. 

 

13.3 Project Viewer – Evaluation 

13.3.1 Internal Reviewers 

The details of an internal assessment can be recorded on the Internal Assessment page. You can 

record as many internal assessments as required. 

 

Tips:  

 Select the Add Assessment option and enter a name for the assessment 

 Enter comments (Summary page), attractiveness scores (Attractiveness page) and Feasibility 

scores (Feasibility page) 

 Select the Assessment scores have been reviewed checkbox on the Summary page 

 Click the Finalised button in the Internal Assessments grid to finalise the assessment 
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13.4 Project Viewer - Management 

13.4.1 Classifications 

Classifications can be added to projects to make it easier to generate reports or to search for projects 

with the same classification. To add a classification to a project:  

1. Open the project in Edit mode 

2. Select Management>Classifications 

3. Select Add classification 

 
Figure 13 19 : The project classification screen. 

4. Select the classification name. 

 
Figure 13 20 : The project classification data entry fields. 

5. Select the classification value 
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6. Click OK 

 
Figure 13 21 : The project classification data entered. 

Tips:  

 You can add as many classifications as you like to a project.   

 If a classification is required, a message will appear at the top of the page. 

 If the number of values that can be added for a classification name is exceeded, a message 

will appear. 

13.4.2 Clinical Trial – First Patient Enrolment 

The Clinical Trial – First Patient Enrolment is accessible as follows:  

 
Figure 13 22 : The Clinical Trial – First Patient Enrolment. 
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Figure 13 23 : The Clinical Trial – First Patient Enrolment – data entry. 

13.4.3 Comments Log 

Comments can be viewed and created from the project comments screen or from the project 

comments node.  

 
Figure 13 24 : The Comments screen. 

1. Click the + symbol to create a new comment. 
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Figure 13 25 : The Comments screen. 

 

2. Type the comments in the box and click OK. 

 
Figure 13 26 : The Comments screen. 

 

3. Alternatively, you may click on the  from the floating menu and the following is 

displayed from the right side of the screen. 

 
Figure 13 27 : The Comments screen from the floating menu. 
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4. Note that you can only delete your own comment, but you can view comments added by 

all users. 

 
Figure 13 28 : The Comments which are available from different users. 

5. The user photo is maintained in REGIS Contact Relationship Management. 

13.4.4 Contacts 

Project contacts are added during the transfer process using the contact information entered into the 

application. They can be updated and added to during the life of the project. 

 

Figure 13 29 : The available Contacts of a project. 

 

1. Click Add contact from the menu. 

 
Figure 13 30 : Adding a Contact to a project. 

 

2. Select the person icon to view the contact in REGIS Contact Relationship Management. 
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Figure 13 31 : Viewing a contact launches the REGIS Contact Relationship Management. 

3. In edit mode, select the Edit option to change the person record attached to a contact 

type or to update funding information 

4. Select the Delete option to remove the contact from the project 

5. Select the Save option or navigate away from the screen to permanently save your 

changes 

13.4.5 Decisions 

Approval(s) assignment for an application can be done here. 

1. Click Add Decisions and fill up/select the Approval Type, Entity, and User. 

2. Click Save. 
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Figure 13 32 : Adding decisions. 

 
Figure 13 33 : Select decision type. 

 
Figure 13 34 : Adding users. 
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Figure 13 35 : Added decisions. 

13.4.6 History 

The Project History screen displays a list of activities related to this project similar to the information 

that appears in the system audit trail.  Activity types may be status changed, activities relating to 

processing decision notification letters and project agreements. 

 
Figure 13 36 : The history screen. 

Tips:  

 Click the heading e.g. Type or user, to sort by the column 

 The audit trail includes more information on the activity including before and after values. 

13.4.7 Issues 

Project issues can be captured in the project viewer and reported on in the dashboard.  You can create 

charts comparing the issue ratings, issue consequences and issue probabilities, or visually track the 

active issues per program. 
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Figure 13 37 : The Issues screen. 

 

 
Figure 13 38 : The Issues data entry sample screen. 

 

Tips:  

 Issues feed into the Traffic Light report to generate the colour coding 

 Select the Edit or Delete options to modify a record 

 Select the Save option or navigate away from the screen to permanently save your changes 

13.4.8 Regions 

The project region(s) can be added and updated.  Regions can be reported on using the dashboard 

reporting. 
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Figure 13 39 : The Regions screen. 

Tips:  

 Select Edit (from the floating toolbar) before selecting additional regions 

 Select the checkbox, Show all regions, to either display all regions (by state) or to display 

regions for specified states only 

 You can select as many regions as required 

 
Figure 13 40 : The selected regions. 

 Deselect a state to remove the region from the project 

 Select the Save option or navigate away from the screen to permanently save your changes 
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13.4.9 Related Documents 

Saving documents in a central, offsite location can assist with disaster recovery and communication 

within a team.  

The related documents screen supports two view options.  You may group your documents by type 

(aggregate view illustrated below) or list all documents (table view ). 

 
Figure 13 41 : The Related Documents main screen. 

 
Figure 13 42 : Adding external document to the project. 

Tips:  

 To add a document or bulk upload documents, select Add external document from the 

menu 

o Click or drag and drop your files on the drop zone 

o Select a document type and click Save 

 
Figure 13 43 : Adding new external document to the project. 
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 Only certain document types may be edited. When editing a document, select the Replace file 

option to display the drop zone. Simply drag a new file to the drop zone and select Save to 

replace the file. 

 
Figure 13 44 : Uploading new external document to the project. 

 Some document types cannot be deleted 

 Documents that can be deleted will have a delete icon   

 Documents that can be edited will have an edit icon   

 All documents can be downloaded and viewed   

 Select the check boxes beside the documents to enable the Bulk download option. This 

command downloads the selected files in a zip file. 

 In aggregate view, select the document type banner to expand the display.  Note that you can 

select all documents of that type using the select all checkbox. 

 
Figure 13 45 : The uploaded documents in aggregate view. 

 To view only documents of the document type (full screen), select the Expand button  

 Select the Back button to return to the expanded view and select the document type title in 

brackets to return to aggregate view. 
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13.4.10 Status 

The project status reflects the project stage - from the start to the completion of a project.  Various 

functions can only be performed for projects that have a particular status and reports are often run by 

status.   

 
Figure 13 46 : The uploaded documents in aggregate view. 

Common status descriptions include the following:  

Status Remark 

Active All actively managed projects.  Once a project agreement is 

signed the status is automatically changed to active. 

Approved (EOI invited) The application has been approved to move to the next stage 

(for a two application), or will be invited to negotiate a 

contract. 

Unsuccessful The application was unsuccessful and will not be granted 

funding 

Pending eligibility assessment Status given to an application that has been transferred but has 

not been checked for eligibility 

Eligible Awaiting assessment – passed the eligibility assessment 

Ineligible Failed the eligibility assessment 

Terminated Project terminated 

Figure 13 47 : Common project status descriptions. 

Tips:  

 While in edit mode, select the Add Status option and complete the form. 

 Select the Edit or Delete options to modify a record 

 Select the Save option or navigate away from the screen to permanently save your changes 

 Some status descriptions can be modified by your system administrator. 
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13.4.11 Tasks 

Tasks are a helpful way of communicating and keeping track of project related tasks. You can allocate 

tasks to yourself or to another user. If you find it helpful, pin the task pane to keep it open. 

 
Figure 13 48 : The Add Task screen. 

 

 
Figure 13 49 : New task added. 

 

Tips:  

 Select Add Task and complete the form 

 All tasks display in the project viewer tasks screen.  Only tasks allocated to you display in the 

tasks pane. 

 Select the Edit or Delete options to modify a record 

 Select the Save option or navigate away from the screen to permanently save your changes 
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13.4.12 Timeline 

The project timeline shows the status updates to a project from the first registered date until current. 

 
Figure 13 50 : The project timeline. 

End of section The Project Viewer 
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 User Defined Dashboards & Reports 

Users with the role Dashboard edit can create and update dashboards.  Users with the role 

Dashboard view can view dashboard items shared with them. If you have either of these roles, you 

will see the Dashboard tile on the Start page.  

14.1 Viewing a dashboard 
To view a dashboard:  

1. Select the List option from the Dashboard menu 

The default dashboard (marked with a  ) is displayed 

2. Move your mouse over the dashboard tile 

3. Select Preview (  ). 

The dashboard is displayed 

Note:  

 To ensure the dashboard values are up to date, select Refresh (  ).   

 The dashboard with the green tick is your default dashboard. It will display automatically 

when you select Dashboards.  To modify your default dashboard, select Default (  ). 

 You may be able to Drill Down to view the data in a different way.  For example, you may be 

able to select a project series and drill down to view a representation of projects by status. 

 To drill up, select the Drill Up (  ) icon in the top right hand corner of the object. 

 The Export (  ) icon will have different options depending on the object type.  Charts can 

be exported to a PDF or an image and chart data can be exported to Excel.  Grid data can 

also be exported to Excel. 

 Click on the Remove Filter (  ) icon to remove data filters.  

14.2 Adding a dashboard 
Saving a dashboard to the server from the Dashboard Designer (refer to the Dashboard Designer 

Guide) automatically adds it to your dashboard list.  To add a dashboard file (.xml) manually, follow 

the steps below:  

1. Select the Add option from the dashboard menu 

2. Complete the Add dashboard form 
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Figure 14 1 : Adding new dashboard. 

3. Click OK 

 

Note:  

 In the screenshot above, the default option is selected.  Selecting default will automatically 

set this dashboard as your default dashboard. 

 You may use an existing dashboard file saved previously or from another user. Just drop it 

into the Dashboard File box. 

14.3 Deleting a dashboard 
When you delete a dashboard it will only delete the dashboard from your list – anybody that you 

have shared the dashboard with, or shared the dashboard with you, will not be impacted. Anyone in 

possession of the .xml file used to create the Dashboard will still be able to open the file using the 

Dashboard Designer.  To delete a dashboard:  

1. Select the List option from the Dashboard Menu 

2. Select the dashboard to delete 

3. Select the Delete button 

4. Select Yes to confirm 

14.4 Editing a dashboard 
To change the dashboard name, description or replace the .xml file for the dashboard:  

1. View the dashboard 

2. Select the Edit option from the menu 

3. Enter a new name, description or default status 

4. Select the Change Dashboard Design option (optional step) 

5. Add the new .xml file to the upload file area  

6. Click OK 

 

Note:  

 You may choose the Download File option to save a local copy of the .xml file.  You will then be 

able to open the .xml file in the Dashboard Designer to modify the content. 

14.5 Share a dashboard 
To make your dashboard available to another user to view, you can Share the dashboard.  

1. Select List from the Dashboard menu  

2. Click on the dashboard to share 

3. Click the Share button 

4. Click the Add button 

5. Search for and select the user  
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Figure 14 2 : Sharing dashboard with other users. 

 

6. Repeat steps 4 and 5 as many times as desired 

7. Click OK 

 

14.6 Share a dashboard with an REGIS External Portal user 
You can create and share a dashboard with a REGIS External Portal user.  A Dashboard icon will 

automatically appear in the REGIS External Portal Menu to enable the user to navigate to view the 

dashboard data.  This is a two-step process: 1) modify the user access; 2) share the dashboard. 

To enable the user to view the dashboard they must have the Net dashboard view role.  Refer to 

User Management for more information. 

 
Figure 14 3: The REGIS External Portal dashboard view access rights. 

 

To share a dashboard with an OminNet user follow the steps in Share a dashboard.  The Dashboard 

icon appears in the REGIS External Portal menu. 

 
Figure 14 1 : The Dashboard menu. 

 

Tips:  

 If an REGIS External Portal user has a single dashboard it will automatically appear. 
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 If an REGIS External Portal user has more than one dashboard available to them, they can select 

them from the left navigation menu.  

 
Figure 14 2: The Dashboard options. 

 

14.7 Export a dashboard 
You can print or export a dashboard in a variety of formats.  Click on the Export button to view the 

list. 

 
Figure 14 3: Exporting a dashboard. 

Tip:  

 Each object on a dashboard can be exported individually 

 Use the export button in the top right hand corner to export all objects on the dashboard 

14.8 Download the Dashboard Designer 
The Dashboard Designer is used to create custom dashboards.  Select Download designer from the 

menu to begin the process of downloading and installing the Dashboard Designer.  Once the 

Dashboard Designer has been installed you can run it at any time using the shortcut on your 

desktop. 

1. Select REGIS Internal Portal Dashboard Designer from the Start menu 

 
Figure 14 4: The login credentials for Dashboard/Report Designer. 

 

2. Enter your username  

3. Enter your password  

4. Click OK 

5. You should then see the window below 
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Figure 14 5: Choose Dashboard Designer. 

 

6. Double click Dashboard Designer. 

 
Figure 14 6: Add New Data Source. 

 

To create a data source:  

7. From the Ribbon, click Data Source 

8. Click Download 

9. The Download window is displayed 

 
Figure 14 7: Select date for data download. 

 

10. Select the day for which you wish to download data.  This will download a snapshot of data as 

at the selected date.  

11. Click Download 

12. The data for the selected day will be downloaded and you will see the following window. 

 
Figure 14 8: Data download progress. 
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13. Once the download has been completed the window above will be closed and you will be ready 

to create and update dashboards.  

Note:  

 The day will be defaulted to the current date. It is suggested that the data is downloaded each 

time you logon to the Dashboard Designer so the most recent version of the data is available 

for you to build dashboards against. 

14.8.1 Creating a data source 

You can begin adding items (charts/grids) to the blank canvas (illustrated above) but no data will 

display until you:   

1. Download data. This downloads data to your computer to assist you to design your dashboard.  

You can do this whenever you like to ensure you are working with the most recent data in the 

Dashboard Designer.  Note: When viewing a dashboard in REGIS Internal Portal you simply click 

the Refresh button to ensure you are looking at the most recent data. 

2. Create a data source to link your new dashboard with the relevant datasets.  

3. Add elements (fields) to the DATA ITEMS area  

To download data:  

1. Select the Data Source tab on the Ribbon 

2. Click Download 

3. The Download window is displayed 

 
Figure 14 9: Data download selection by date. 

4. Select the day for which you wish to download data 

Note: This will download a snapshot of data for seven days up to and including the date you 

selected. 

5. Click Download 

6. The data for the selected day will be downloaded and you will see the following window 

 
Figure 14 10: Data download. 

7. Once the download has been completed the window above will be closed and you will be 

ready to create and update dashboards 
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Note:  

 The day will be defaulted to the current date. It is suggested that the data is downloaded 

each time you logon to the Dashboard Designer so that the most recent version of the data 

is available for you to build dashboards against. 

Create a new Data Source 

A Data Source specifies the datasets (e.g. Projects, Contacts) you are interested in. 

1. Select the Data Source tab and click the New Data Source button 

2. Name your data source appropriately 

Note: This name will be for your own reference only, and will not be visible in the Dashboard 

that you create. 

 
Figure 14 11: Key in the new datasource name. 

 

3. The Query Designer is displayed.  The Items column lists all the available datasets.  Each 

dataset includes a collection of relevant fields. 

4. Select an Item and drag it to the Name section 

 
Figure 14 12: The query designer. 

 

Note: The system automatically disables any items in the left hand panel that cannot be easily 

joined to the selected item.  If you need to join a greyed out item, drag the table to the 

middle section and manually complete the Condition Editor form. 

5. If required, select additional items (datasets) and drag them to the Name section 

The system automatically displays the Condition Editor 
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Figure 14 13: The condition editor. 

6. Important! Select the Left out join option  

Note: these conditions can be modified if required; however this should only be done if you are 

confident you understand why and how they need to change.  Refer to the notes at the end of 

this Quick Reference Guide for more information. 

7. Click OK 

8. Select the columns for use in the dashboard by checking the boxes beside them 

Note: You can select all checkboxes by selecting the one beside the label of the Item (in the 

above image, this is the highlighted Row, labelled Project in the illustration to the right). 

 
Figure 14 14: The condition editor. 

The Query Designer is updated with your selections 

9. Important! Click Filter… 
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Figure 14 15: The Filter Editor is displayed 

10. Add a filter (if required) noting that filters can be added and removed in the Dashboard 

Designer 

Note: Almost always you will want to add a filter that only looks at data that has a Date 

Recorded that Is today.  Select the Preview Results button (bottom right hand corner) to 

preview the data you will be working with. 

11. Click OK 

The System displays the Maintain Dashboard Screen 

14.8.2 Design your dashboard 

You are now ready to begin designing your dashboard report by adding data elements to the DATA 

ITEMS area. 

1. From the Home tab of the ribbon, select a data visualisation element such as a Pivot table, Grid or 

Chart to add it to the canvas.  You can size and move these around later. 

2. Select a data element (field) from the far left panel to the DATA ITEMS panel.  

3. Drop the data item on a box in the DATA ITEMS panel.  Note that for a Pivot table, adding the 

Project Title to the Columns area will display it across the page, adding Project Title to the Rows 

area will display it down the page and adding it to the Values area will count the number  of 

records. 

The Grid will update as data elements are added. 

4. Use the tools on the Data tab to add filters and drill-down capability. These tools are explained in 

more detail later in this Quick Reference Guide  

5. Select a format from the Design tab 

14.8.3 Save the dashboard 

You can save the dashboard locally (using the options in the File group) or save and upload to the 

server (using the options in the Server group).  Save to the server when you are ready to view the 

dashboard in REGIS Internal Portal. 

1. Select the Home tab 

2. Select Save or Save As (Server)  
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3. If the dashboard has not been saved previously or the Save As button is clicked the following 

window will be displayed:  

 
Figure 14 16: Keying in the dashboard details. 

4. Enter the relevant details in the Dashboard Details window 

5. Click OK 

14.8.4 Create a new dashboard 

1. Select the Home tab on the Ribbon 

2. Click New 

 
Figure 14 17: Creating a new dashboard. 

3. You will now need to configure a new Data Source  

14.8.5 Load dashboard 

1. Select the Home tab 

2. Select Open from the Server area   

Note: Dashboards saved to the server can be viewed from within REGIS Internal Portal.  

Dashboards saved locally (using the Save option in the File group) can only be viewed from 

within the Dashboard Designer. 
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Figure 14 18: Opening an existing dashboard. 

3. The Dashboards window will be displayed listing all dashboards that you have access to open 

from the server 

 
Figure 14 19: The available dashboards. 

4. Select the dashboard you would like to open and click OK  

14.8.6 Logoff the Dashboard Designer 

1. Click the X in the top right hand corner of the Dashboard Designer. 

14.8.7 Using the Dashboard designer - Dashboard Editor 

 

Figure 14 20: The dashboard editor 
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Dashboard Data Sources and Element Data– This displays all the available Dashboard datasets (click 

on the down arrow to view the list) and associated element data (these were selected when the 

Dashboard Data Source was created). 

Dashboard Ribbon – This displays all the functions available for use including visualisation elements, 

layout options and drill down/filtering options. 

Dashboard Canvas – This area displays all of the Dashboard Elements for the selected Dashboard.  

A Dashboard Element is a Grid, Chart, Graph, etc. These can be customised, resized and positioned 

as required using drag and drop functionality. A full list of Dashboard Elements can be seen in the 

table below. 

The Dashboard Ribbon has 13 different data visualisation elements each with different strengths 

and options. These can be accessed from the Dashboard Ribbon.   

 
Figure 14 21: The dashboard ribbon. 

 

Pivot The pivot dashboard element enables a cross-sectional view of data pivoted across 

multiple dimensions. 

Grid The grid enables a standard tabular representation of data. This dashboard 

element also contains embedded visual cues and displays that assist in quickly 

understanding data. 

Chart This quintessential visualisation tool assists in the creation of bar, point, line, area, 

range, bubble, and financial charts. The creation mechanism has also been 

significantly streamlined in order to visualize your data with simple drop actions. 

Pies The pie chart is a powerful visualisation tool that enables users to understand 

distributions over small ranges. 

Gauges Gauges allow the comparative visualisation of two values where one represents a 

target and the other an actual value. This dashboard element also allows for a 

multiplicity of gauges in a single dashboard element by creating a series view of 

the same. 

Cards Cards, similar to gauges, are a textual visualisation of target to actual values. These 

additionally include easy to understand positive/negative visualisations as well as 

easy to consume data explanations.  

Choropleth 

Map 

The choropleth map provides an easy way to visualize how a measurement varies 

across a geographic area or it shows the level of variability within a region. 

Geo Point 

Map 

The Geo Point Map dashboard item allows you to place callouts on the map using 

geographical coordinates. 
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Range 

Filter 

The range filter is also a brand new visualisation tool that allows for automatic data 

filtering by presenting a chart based range. The range filter is automatically wired 

up to be a master filter and enables users to drill down into specific data 

effortlessly. 

Image Creates an image dashboard element for display in the dashboard.  Select the Load 

Image option from the Design tab to select the image file. Format the image using 

the format options on the Design tab. 

 

Text box Creates a text box item.  Double click in the text box item to enter text.  All the 

normal formatting options are included. 

 

Filter 

Elements 

Filter elements are used to apply filtering to other dashboard items. The combo 

box allows the user to select a value from the dropdown list. The List box allows a 

user to select multiple values from a list of items. The tree view items displays 

values in a hierarchical way and allows you to expand and collapse nodes. 

Group The group element allows you to keep two or more existing dashboard elements 

together by dropping them into the Group box. 

Table 14 1: The dashboard ribbon menu. 

 

A data element (field) can be dragged from a Dashboard Source to the Data Items area.  The 

available areas will change depending on whether are working with a Pivot Table, Grid, Chart, etc. 

Some of the areas where these can be dragged are:  

1. Values – the Y axis in the case of a chart (or the values of the items being measured)  

2. Columns –data is listed across the page 

3. Rows – data is listed down the page 

4. Arguments – this can be considered as the X axis (or the items being measured)  

5. Series – different sets of (X, Y) pairs  

Additionally, drag data elements directly into the Hidden Data Items section to do additional sorting, 

filtering, and data shaping on values and arguments that are not necessarily visible in the actual 

Dashboard. You will be able to shape data as you see fit – even with data elements not present in 

the visualisation. 
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Note: Depending on the field type  e.g. Text, Money, etc. and the Dashboard Element type e.g. 

Chart, Grid, the options available in the Data Items area will change. For example, with a Card or 

Grid, you will be able to select how the data is aggregated (sum, count, average) and configure 

targets, warnings and positive/negative indicators.  For a Chart you will be able to select different 

types of charts for each field. 

14.8.8 Dashboard Layout 

Each Dashboard Element has item specific layout capabilities. These capabilities allow for the look 

and feel of the Dashboard Element to be customised.  A few examples are below:  

Chart 

 

Grid 

 

Cards 

 

Table 14 2: The dashboard layout styles. 

 

These layout options are element specific and allow for flexibility and personalisation of your 

Dashboards.  

Dashboard Elements can also have the labels, headings and other aspects further customised. To 

modify names:  

1. Select the Dashboard Element, e.g. a chart 

2. Select the Design Ribbon Menu 

3. Select the Edit Names option 

14.8.9 Interactivity 

Every Dashboard Element visualisation is linked to a specific set of data (data source). Because of 

this data connection, Dashboard wide filtering as well as simple element drill down can be 

configured.  

Filtering and drill down functionality is available from the Data Menu Ribbon (see below). Each 

Dashboard Element has this functionality. 
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The Data Menu Ribbon allows you to define a Dashboard wide filter, drill down, as well as the ability 

to define whether or not a dashboard element even participates in a filter.  

 

This allows a specific filter to be configured for the 

selected Dashboard Element. To configure a filter, click 

Edit Filter. From here the Filter Editor window will be 

displayed which will allow you to specify a filter from 

any of fields for the selected Dashboard Element. 

 

If a filter has been configured it can be cleared by 

clicking Clear. 

 

The Dashboard allows you to use any data-aware 

dashboard element as a filter for the entire dashboard 

(Master Filter). You can select elements in a Master 

Filter item (chart bars, pie segments, grid records, etc.) 

to filter data in other areas of the dashboard by the 

selected values. 

Multiple: Allows you to select multiple elements in the 

Master Filter item. To clear the selection in the Master 

Filter item, use the Clear Master Filter button in the 

dashboard element’s caption. 

  

Single: Allows you to select only one element in the 

Master Filter item. When this mode is enabled, the 

default selection will be set to a Master Filter element. 

You can change this selection, but cannot clear it.  

Drill Down: The drill-down feature allows you to 

change the detail level of data displayed in a dashboard 

item by row or by column. This feature allows you to 

drill down to display the details, or drill up to view 

more general information 

 

Selecting this option configures the Dashboard Element 

to ignore any filters from other Dashboard Elements. 
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Selecting this option allows for the Dashboard Element 

to filter other Dashboard Elements automatically even 

if the data source for the other Dashboard Elements is 

different to the data source of the selected Dashboard 

Element.  Note that the Dashboard Elements must 

share a commonly named data element. 

 

Specify the initial state of expand and collapse groups 

for a pivot item. 

 

Filtering by Arguments: When filtering by arguments is 

enabled, you can click series points to make other 

dashboard items display only data related to selected 

argument values. 

Filtering by Series: When filtering by series is enabled, 

you can click a series point to make other dashboard 

items display only data related to the selected series. 

Table 14 3: The dashboard data filtering. 

14.8.10 Extra information:  

Joining data: There may be reasons why you want to join data tables using an Inner Join. If you need 
to only return records when there are rows in both tables (e.g. you might only want Projects which 
have Milestones) using an Inner Join can be the perfect solution.  Using an Outer Join would return 
all projects – whether they have milestones or not.  We recommend using an Outer Join and filtering 
out unwanted records manually, unless you are sure you understand the difference and are 
prepared to risk ‘losing’ records.   

Multiple data sources: You can create multiple data sources for a dashboard.  Each element (pivot, 

grid, chart) can be linked to either a common or a different data source.  When multiple data 

sources are in use, you can use the Cross-Data-Source Filtering to applying filtering across data 

sources. 

14.8.11 Custom maps 

Before you Begin 

The Dashboard/Report Designer comes equipped with a host of regional maps, however you may 

want to use one that you have sourced yourself. This process is supported, so long as the map you 

wish to use is an ESRI SHP file (include these acronyms when searching for a map to use). An example 

of such a map can be found here:  

http: //data.daff.gov.au/data/warehouse/nsaasr9nnd_022/nsaasr9nnd_02211a04es_geo___.zip 

The above links to a Zip file, containing a set of files which, together, comprise a map of Australia. 

Before following the below instructions, you should save a map (whether the one linked above or one 

of your own selection) to a location on your local computer that you can navigate back to when the 

time comes. 

http://data.daff.gov.au/data/warehouse/nsaasr9nnd_022/nsaasr9nnd_02211a04es_geo___.zip
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Note: Once a map has been saved into a Dashboard, the source Map file is no longer needed for that 

Dashboard to run and display the custom map correctly. 

 

Getting Started 

1. Open Dashboard/Report Designer 

2. Click the Data Source tab in the Ribbon 

3. Select Download 

4. Enter Username 

5. Enter Password 

6. Select From Date 

7. Select To Date 

8. Check Delete existing data 

Allow the Download process to complete. You will be notified once this is done. 

 

Adding an Address Data Source 

1. From the Ribbon, select New Data Source 

2. Name your Data Source 

3. Select OK 

4. Select the Address item from the list by double-clicking it 

5. In the upper central pane, check the box beside Address to select all data items for use 

6. Click the Filter button at the bottom left of the window 

7. Click the  icon to add a new Filter 

8. Click on the blue text in the new Filter and select Date Recorded from the menu that appears 

9. Click on the green text in the new Filter and select Is Today 

10. Select OK 

11. Select OK 

 

Adding a Map Element 

1. Click the Home tab in the Ribbon 

2. Select Geo Point Map 

 

Customising the Map 

1. Click the Design tab in the Ribbon 

2. Navigate to the location containing the Custom Map 

3. Select the .SHP file 

4. Select Open 
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Adding Data to your Map 

1. Drag the Latitude item into the DATA ITEMS pane labelled Latitude 

2. Drag the Longitude item into the DATA ITEMS pane labelled Longitude 

3. Drag the Address Id item into the DATA ITEMS pane labelled Value 

 

Relabelling Fields for Presentation 

1. Mouse-over, then drop-down the Address Id you just placed under DATA ITEMS 

2. Select Count from the available menu 

3. Mouse-over, then drop-down the Address Id you just placed under DATA ITEMS 

4. Select Rename from the available menu 

5. Replace all text in the Rename Data Item window with the word Count 

 

Adding a “Full Address” Custom Field 

1. Right-Click on the word Address in the far left pane 

2. Select Add Calculated Field 

3. Enter the below into the Expression Editor, being careful to ensure that all single quotes, plus 

symbols and line breaks appear exactly where shown 

[Address Line] + ' 

' + [Suburb] + ' ' + [State] + ' 

' + [Country] + ' ' + [Post Code] 

4. Select OK 

5. Right-Click on the Calculated Field 1 item in the far left pane 

6. Select Rename 

7. Change the text entered to the word Address 

8. Drag this renamed item into the TOOLTIP DATA ITEMS pane labelled Dimensions 

 When you now hover your mouse over any flag shown on the map, the full address will 

appear. 

 

Saving your New Report 

1. Click the Home tab in the Ribbon 

2. Click Save As 

3. Navigate to a location for your Dashboard to be saved 

4. Enter a File name for your Dashboard 

5. Select Save 

 Your new Map Dashboard is now ready to be imported into REGIS Internal Portal! 

End of section User Defined Dashboards & Reports 
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 System Settings 

The System Settings menus are grouped by function.  For example, lookup lists associated with Project 

management are grouped under the Project Lookups menu.  To prevent an item from appearing in a 

lookup list, you may change the status to ‘Inactive’.   

Users with role System View may view the lookup lists filtering by status.  Users with role System Edit 

may add and maintain lookup list items. 

 

If you have been allocated these system roles, you will be provided with additional guidance related to 

those functions. 

End of section System Settings 
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 Workflows 

The Workflow Designer provides a method of configuring the behaviour of REGIS Internal Portal as 

processes are triggered by a user or system action. This end result may be a message, a task, or that 

the property of an object is updated.  For example, workflows are used to manage the Merit 

Assessment process and Conflict of Interest processes. The use of workflows to manage these 

activities allows each organisation to easily adapt the process to suit their organisational processes. 

At the current time, changes to Workflows are managed by System Administration Users and apply 

REGIS-wide. If you have been allocated a System Admin roles you will be provided with additional 

guidance related to this function. 


